OpenGL 3.0+ and Visual Studio 2017 Setup

Wednesday, February 13, 2019 12:50 PM
By Yijia Liu
Steps:
1. Download and install Visual Studio 2017
a. Use this link: https://visualstudio.microsoft.com/downloads/
b. Choose the Community Version. It is free for academic use.

E= Microsoft | Visual Studio  Products v Downloads ~ Marketplace ~ Support ~  Subscriber Access | Free Visual Studio All Microsoft ~ O Q

Downloads
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c. Install Visual Studio 2017.
2. Download GLFW
a. Use this link: https://www.glfw.org/
b. Don't click the "Download GLFW 3.x.x", click the "Download" on top right.

GLFW Documentation Community

GLFW is an Open Source, multi-platform library for OpenGL, OpenGL ES and
Vulkan development on the _dgskt_op. It provides a simple API for creating windows, Releaser! on August 18, 2845
contexts and surfaces, receiving input and events.

GLFW is written in C and has native support for Windows, macOS and many Unix- . o
like systems using the X Window System, such as Linux and FreeBSD. O G il

GLFW is licensed under the zlib/libpng license.
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c. On next page, scroll to "Windows pre-compiled binaries", you either choose the "32-bit Windows
binaries", or the 64-bit one. Most of the time you only need the 32-bit one, especially for
beginner proposes.



G L FW > Documentation Download Community

Download
The current version is 3.2.1, which was released on August 18, 2016 . See the version history for a list of changes.

Source package

This package contains the complete source code, CMake build files, documentation, o R S—
examples and test programs. It is the recommended download for all platforms and P 9
offers the most control.

GitHub repository

The latest version of the source code, including tags for all releases, is always
available in our Git repository.

Windows pre-compiled binaries

These packages contain complete GLFW header file, documentation and release 32_bit Wind -
mode DLL and static library binaries for Visual C++ 2010 (32-bit only), Visual C++ ‘ O INCOWSTDINANES]

2012, Visual C++ 2013, Visual C++ 2015, MinGW (32-bit only) and MinGW-w64.
64-bit Windows

d. Click and download the zip file.

Download GLEW.
a. Use this link: http://glew.sourceforge.net/ (Or Google "glew")
b. Select "Windows 32-bit and 64-bot"

Latest Release: 2.1.0

The OpenGL Extension Wrangler Library

\q ) The OpenGL Extension Wrangler Library (GLEW) is a cross-platform op: C/C++ ion loading library. GLEW provides efficient run-time
v mechanisms for determining which OpenGL extensions are supported on the target platform. OpenGL core and extension functionality is exposed in a single
header file. GLEW has been tested on a variety of operating systems, including Windows, Linux, Mac OS X, FreeBSD, Irix, and Solaris.

Download
Usage Downloads
Building GLEW is distributed d iled binari

Installation is distributed as source and precompiled binaries.

% The latest release is 2.1.0[07-31-17]:
Source Generation
Change Log

—_— Source
itHul . " " ;
Issues Binaries Windows 32-bit and 64-bit

Pull Requests ) _ .
Authors An up-to-date copy is also available using git:

Licensing * github
git clone https://github.com/nigels-com/glew.git glew

SourceForge Page

Last Update: 07-31-17 Supported Extensions

c. Click and download the zip file.

Folder Placement (Setup of the OpenGL programming environment)

Now we have the VS2017, the latest GLFW and the latest GLEW. We can beginning.
a. Extract the previous down/l\oaded GLFW and GLEW zip file.

D Name

glew-2.1.0-win32.zip

i
| glfw-3.2.1.bin.WIN32.zip

|:] Name

glew-2.1.0
glfw-3.2.1.bin.WIN32

b. Now we create another folder for our C++ project directory
Let's name it "CS428".
You can create this folder anywhere for you convenience.
For example | created one on "C:\CS428".



You can later rename this folder (the root folder), move it to a different location / computer, and
it will still run. Because library files will be link to this folder.

c. Inside "CS428", create a folder where the GLFW and GLEW library will be placed. | name it
"External Resources", you can name it whatever you like.

This PC » Windows (C:) » CS428 »
" |:| Name
External Resources

d. Move/copy those two folders with GLFW and GLEW libraries into "External Resources
[] Name

glew-2.1.0
glfw-3.2.1.bin.WIN32

5 PC » Windows (C:) » CS428 > External Resources »
E] Name

glew-2.1.0
glfw-3.2.1.bin.WIN32

e. |suggest renaming GLFW and GLEW libraries folder for easier to maintain.
5 PC » Windows (C:) » CS428 » External Resources

~

|:| Name
GLEW
GLFW

5. Setup a new project in Visual Studio 2017
a. lLaunch Vs2017
b. File -> New -> Project
(o]
File Edit View Project Debug Team Tools Test Analyze Window Help
£ New %> Project.. Ctrl+Shift+N

Open * 1 File.. Ctrl+N
Start Page Project From Existing Code...

Close

Recent

Save All Ctrl+Shift+S This week

Source Control |1 Lect2.sIn
(4] § P
C:\Users\angel\OneDrive\CPP\CS428\Lect2

'1 Lectl.sIn
m i 2 2,
Account Settings... C:\Users\angel\OneDrive\CPP\CS428\Lect2

Recent Files Lectl.sin
M

Recent Projects and Solutions C:\Users\angel\OneDrive\CPP\CS428\Lect1

Exit Alt+F4




C.

e.

Choose: Visual C++ -> Empty Project -> Browse...

New Project ? X

D Recent Sort by: Default M = Search (Ctrl+E

4 |nstalled == N Kot Type: Visual C++

4 Visual C++ A project for an application that runs on

Windows Desktop B Empty Project Visual C++ Windows that has no starting files or
structure. Ideal if you have existing code

P Cross Platform to bring in.

MEC/ATL Windows Desktop Application Visual C++

Test
Other
P Other Project Types

P Online

Not finding what you are looking for?

Name: Project1
Location: C:\Users\angel\source\repos v Browse...

Solution name: Project1 ¥| Create directory for solution

Add to Source Control

OK

Find the project root folder you created. Click "select".

Project Location X
<« v > &3 > This PC > Windows (C:) » v O  Search Windows (C:) P
Organize ~ New folder = - (2]
£5Windows (C) ~  Name Date modified Type °
5520 CS428 2/13/2019 1:35 PM  File fol.
Intel Intel 11/19/2015 12:15 ... File fol
MinGW MinGW 4/6/2018 12:08 PM File fol
OneDriveTemp OneDriveTemp 2/9/2019 3:02 PM File fol
PerfLogs PerfLogs 4/11/2018 7:38 PM File fol
. Program Files 2/8/2019 12:20 AM  File fol
Program Files
Program Files (x86) 2/8/2019 12:20 AM  File fol
Program Files (: )
ProgramData 2/8/2019 12:20 AM  File fol
Programbata Recovery 7/11/2018 5:56 PM  File fol
Recovery Users 7/11/2018 5:57 PM  File fol. v
Users 7 <€ >

Folder: | C5428

Select Folder | Cancel

You see the Location of the Project is changed.
Now we can name the project, for example: Lecturel

New Project ? X

P Recent Sort by: Default

4 |nstalled Type: Visual C++

Windows Console Application Visual C++

4 Visual C++ A project for an application that runs on
Windows Desktop B Empty Project Visual C++ Windows that has no starting files or
structure. Ideal if you have existing code
to bring in.

P Cross Platform '
MFC/ATL E Windows Desktop Application Visual C++




New Project X

P Recent Default Search (Ct P~

4 |nstalled 5
Windows Console Application Visual C++ Type: Visual C++

4 Visual C++ - A project for an application that runs on

Windows Desktop Empty Project Visual C++ Windows that has no starting files or
structure. Ideal if you have existing code

P Cross Platform to bring in.

MFC/ATL Windows Desktop Application Visual C++
Test
Other

P Other Project Types

P Online

Not finding what you are looking for?

Name: Lectureﬂ

Location: @ Browse...
S

Solution name: Lecture1 Create directory for solution

Add to Source Control

@ Cancel

Click "OK".

your new project

View Project Buid Debug Team Tools Test Analyze Window Help Yidia Liu ~
B-Oue Debug x86 P Local Windows Debugger ~ Auto
Solution Explorer v Rx
@EFE- o-- @ F|-
o~
Solution ‘Lecture1" (1 project)

*! Lecture1
b =B References

5
3
8
g

K External Dependencies
8 Header Files

8 Resource Files

# Source Files

Output

Show output from:

Class View Property Man... Team Explorer

4 Add to Source Control &

6. Create main.cpp
a. In"Solution Explorer", right click your project, go to Add -> New Item...

File Edit View Project Build Debug Team Tools Test Analyze Window Help
?ﬁ < ()-"I ] n“ Debug -~ x86 ~ P Local Windows Debugger ~ Auto
v I X
o-- 8@ pf-=
ution Explorer (Ctrl+ P~

m Solution ‘Lecture1’ (1 project)




External Dep
"l Header Files
Ml Resource File
™8 Source Files

Rebuild

Clean

View

Analyze

Project Only

Retarget Projects

Scope to This

New Solution Explorer View
Build Dependencies

Class Wizard... Ctrl+Shift+X
Manage NuGet Packages...

Set as StartUp Project

Debug

Source Control

Ctrl+Shift+A
Shift+Alt+A

New ltem...
Existing Item...
New Filter
Reference...
Class...

Resource...

g Add New Item - Lecture1
4 |nstalled

4 Visual C++
Code
Formatting
ATL
Data
Resource
Web
Utility
Property Sheets
Test
HLSL

Graphics

b Online

C:\CS428\Lecturel\Lecture1\

Name:

Location:

7. Link libraries to project

C++ File (.cpp)

Header File (]

C++ Class

a. Right click your project -> Property

Vieoel @ae Type: Visual C++

Creates a file containing C++ source code

Visual C++

Visual C++

Browse...

@ Cancel




g] e
File Edit View Project Build Debug Team Tools Test Analyze
Bl Debug -~ x86 - » Log

Solution Explorer v B X maincpp
-5 @ k= &l Lecturet

P~
e1' (1 project)

4 Build
I External Depen Rebuild
#8 Header Files Clean
8 Resource Files
2l Source Files
+ main.cpp

View

Analyze

Project Only

Retarget Projects

Scope to This

New Solution Explorer View
Build Dependencies

Add

Class Wizard. Ctrl+Shift+X
Manage NuGet Packages.
Set as StartUp Project
Debug

Source Control

Cut Ctrl+X

Remove
Rename

Unload Project

Rescan Solution

Display Browsing Database Errors

Clear Browsing Database Errors

e older in File Explorer
Properties

b. On next window, make sure:
Configuration: "All Configuration"

Lecture1 Property Pages

Configuration: |Active(Debug) v | Platform: Active(
Active(Debug)
4 Configuration| Debug al
General Release Platform
pebugging [T < 50K Version
VC++ Directories Output Directory
b C/C++ Intermediate Directory
b Linker Target Name
> Manifest Tool Target Extension
NVRAAL Pamiiinn am 4 M mm e P & m

’latform
vs SDK Versi(All Platforms

Nirectary

c. Go to: C/C++ -> General -> Additional Include Directories -> Edit
(If you skipped creating "main.cpp” in the previous step", "C/C++" tab can't be found.)

Luninygurauvr. Al Lonngurauons e rlauuviin. ALCUVE(VINDL) Lonngurauon vianayer...
4 Configuration Properties N
General Additional #using Directories <Edit...> ‘
Debugging Debug Information Format <different options>
VC++ Directories Support Just My Code Debugging  <different options>
C/C+> Common Language RunTime Suppor
General Consume Windows Runtime Extensio
Optimization Suppress Startup Banner Yes (/nologo)
Preprocessor Warning Level Level3 (/W3)
Code Generation Treat Warnings As Errors No (/WX-)
Language

Warning Version

Precompiled Headers Diannnctire Farmat Claccic (/diannncticeclacsic)

d. Inthe pop-up window, type in  $(SolutionDir)/../External Resources/GLEW/include



Additional Include Directories ? X

X v
$(SolutionDir)/../External Resources/GLEW/include ~

v

< >

Evaluated value:

C:\CS428\Lecture1\/../External Resources/GLEW/include
%(AdditionallncludeDirectories)

Inherited values:

Inherit from parent or project defaults VE@Esss

OK Cancel

"S(SolutionDir)" is where your project file is:
> This PC > Windows (C)) » CS428 » Lecturel >

A

~ [ Name

A

Lecture1

fad Lecturetsin.,

"../" is go back one directory.

v > This PC » Windows (C:) » CS428 »
|:| Name

External Resources
Lecture1

"/External Resources/GLEW/include" is what we are linking.
v 1 > This PC » Windows (C:) » CS428 » External Resources » GLEW >

~

[ Name Date modified Ty
bin 2/13/2019 1:41 PM Fil
doc 2/13/2019 1:41 PM Fil

include 2/13/2019 1:41 PM Fil

lib Date created: 2/13/2019 1:41 PM }/13/2019 1:41 PM Fil

— LICENSE.txt Size: 1.38 MB 13/2019 1:22 PM Te
Folders: GL

e. Same thing goes to the GLFW
You can copy and paste and just change "E" with "F", if you used the naming strategy mentioned
in step 4.e.



a.

Additional Include Directories ? X
- X ]
$(SolutionDir)/../External Resources/GLEW/include ~
$(SolutionDir)/../External Resources/GLFW/include
v
< >
5| Evaluated value: ‘
1
C:\CS428\Lecture1\/../External Resources/GLEW/include A
C:\CS428\Lecture1\/../External Resources/GLFW/include v
Inherited values:
a
Inherit from parent or project defaults MEEEEss
OK Cancel
[ 2
f. When done typing/copying, click OK.
8. Link libraries (part 2)
Go to: Linker -> General -> Additional Library Directories -> Edit
Lecture1 Property Pages X
Configuration:  All Configurations v Platform:  Active(Win32) v Configuration Manager...
4 Configuration Properties ~ Output File $(OutDir)$(TargetName)$(TargetExt)
General Show Progress Not Set
Debugging Version
VC++ Directories Enable Incremental Linking <different options>
4C/C++ Suppress Startup Banner Yes (/NOLOGO)
General Ignore Import Library No
Optimization Register Output No
Preprocessor Per-user Redirection No
Code Generation & Additional Library Directories @"
Languag? Link Library Dependencies f{dit..a
Precompl'led Headers Use Library Dependency Inputs No
Output Files Link SHts
Browse Information Prevent DIl Binding
Advanc.ed Treat Linker Warning As Errors
Al Optlo': i Force File Output
. COmEEnC s Create Hot Patchable Image
@ Specify Section Attributes
Manifest File
Debugging
System
Optimization
Embedded IDL
Windows Metadata
Advanc.ed Additional Library Directories
All Options Allows the user to override the environmental library path. (/LIBPATH:folder)
Command Line v
OK Cancel Apply

b. Almost the same with the previous "$(SolutionDir)/" path, but a bit different:

You can still copy and paste to save your time.




»1 Additional Library Directories ? X b
g - X ]
3¢ |$(SolutionDir)/../External Resources/GLEW/lib/Release/Win32 ~lp
$(SolutionDir)/../External Resources/GLFW/lib-vc2015 5
v
< >
E

*{ Evaluated value:

C:\CS428\Lecture1\/../External Resources/GLEW/lib/Release/Win32 A
C:\CS428\Lecture1\/../External Resources/GLFW/lib-vc2015 v

1 Inherited values:

e
)
:

Inherit from parent or project defaults VE@Esss
t
i OK Cancel

A

T
| am pretty sure you won't have the "lib-vc2017" inside GLFW folder, by now. But "lib-vc2017"
works just fine.

e. Click OK.

9. Link libraries (part 3)
a. Go to: Linker -> Input -> Additional Dependencies -> Edit

Lecture1 Property Pages 4 X
Configuration:  All Configurations v Platform: Active(Win32) e Configuration Manager...
.
4 Configuration Properties A~ )[ealIRZ,Iib;uuid.lib;odchZ,lib;odbccp32.Iib;%(AdditionalDependencie@
General gries kEdit..AQ
Debugging Ignore Specific Default Libraries
VC++ Directories Module Definition File
4C/C++ Add Module to Assembly
General Embed Managed Resource File
Optimization Force Symbol References
Preprocessor Delay Loaded Dlls
Code Generation Assembly Link Resource
Language
Precompiled Headers
Output Files
Browse Information
Advanced
All Options

Command Line

General

d'l;‘lggs’( File

Debugging

System
Optimization
Embedded IDL
Windows Metadata

Advanc.ed Additional Dependencies
All Options Specifies additional items to add to the link command line. [i.e. kernel32.lib]
Command Line v
oK Cancel Apply
b. Typein:

opengl32.lib



glew32.lib
glfw3.lib

Additional Dependencies ? X

opengl32.lib
glew32.lib
glfw3.lib

(e}

w

Evaluated value:

opengl32.lib N
t|| glew32.lib
glfw3.lib

Inherited values:

kernel32.lib A
user32.lib
gdi32.lib
winspool.lib

AV O

LIS )

in I Inherit from parent or project defaults VEEEss s

OK Cancel

hreie

"opengl32.lib" is included in the Windows 10.

For "glew32.lib" and "glfw3.lib" spellings, you can check files in "\GLEW\lib\Release\Win32" and
"\GLFW\Ilib-vc2015" to verify.

lesources > GLEW > lib » Release » Win32

A O Name
B glew32.lib
B glew32s.lib

nal Resources » GLFW » lib-vc2015
D Name

) glfw3.dll
i glfw3.lib
B glfw3dlllib

Click OK.
d. Click Apply.
e. Close Property window.

o

10. Link libraries (Part 4)
a. Goto your folder and copy the "glew32.dIl"



- CS428 > External Resources > GLEW » bin > Release > Win32

A

] Name Date modi
[ % glew32.dll 2/13/2019
‘B glewinfo.exe 2/13/2019

] visualinfo.exe 2/13/2019

b. Go to your project folder, where your main.cpp file is. Paste the glew32.dll file to that location.

dows (C:) » CS428 > Lecture1l > Lecture1
|:| Name

M 4 glew32dll
| Lecturel.vcxproj
B Lecture1 .vexproj filters
@ Lecture1.vcxproj.user

0 main.cpp

¢. Go to where your solution file (.sIn file) is, create a folder called "Debug'
dows (C:) » CS428 > Lecturel >

~

D Name
Vs
Debug
Lecture1

R Lecture1.sin
Paste the .dll file inside folder "Debug"
dows (C:) » CS428 » Lecturel » Debug

|:| Name
i glew32dll

d. Go back the where your solution file (.sIn file) is, create a folder called "Release".
Paste the .dll file in there as well.
Jows (C:) » CS428 > Lecturel »

A

1 Name
Vs
Debug
Lecture1
Release

EE Lecturel.sin

ows (C:) » CS428 > Lecture1l > Release
D Name

) glew32.dll



11. We are all set!

12. Copy code into main.cpp and test the result. Click green arrow to run.
2

File Edit View Project Build Debug Team Tools Test Analy;

Q- B-am- Debug - x86 - ¥ Local Windows Debugger

Solution Explorer ¥ B X main.cpp iR
= FE Fl= %] Lecture1 (Global Scope) main()
P~
3] Solution ‘Lecture1’ (1 project)
4 ™ Lecturel
b w8 References
b WF External Dependencies
# Header Fil
# Resource Files
Source Files

main.cpp

cout
fuTerminate

100% -
Output

Show output from:

*Lecturel. e \Windows\SysWOWe4\crypt32.d11°. Cannot find or open the PDB file.
\Windows\SysWoWea\msctf.d11". Cannot find or open the PDB file.
*. Cannot find or open the PDB file.
verStore\FileRepository\64gh6299. inf_amds4_94401bd29769cd59\ig9icd32.d11". Cannot find or of
\Windows\SysWOW64\dxgi.d11'. Cannot find or open the PDB file.
\Windows\SysWOW64\ResourcePolicyClient.d11'. Cannot find or open the PDB file.
Unloaded ‘C \SysWOW64\ResourcePolicyClient.d11"

»

A Add to Source Control «

View Project Build Debug Team Tools Test Analyze Window YisiaLiu ~ oly

Diagnostic Tot
8} Select Tools ¥ [ Output
Summary Events Memory Usage CPU Usage

& Solutior

. Events
B B Learn OpenGL

@ Show Events (0 of 0)

Memory Usage

& Enable heap profiling (affects performance)
CPU Usage

Record CPU Profile

gltwTerminat
1 -1

100% ~

Autos

ass View Locals Threads Modules Watch 1 Breakpoin on Settings Output

A Add to Source Control «

Success!



